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OVERVIEW OF OFFICE 365 

Office 365 Launched in 2001 is a cloud-based, subscription version of Microsoft’s popular suite Microsoft 
Office. Office 365 comprises the same essential applications as traditional versions of Office, including 

Word, Excel, Access, PowerPoint, OneNote, Outlook and others (depending on the plan purchased). 

Other inclusive apps are Publisher, OneDrive, SharePoint, Skype, Microsoft Teams, etc. 

Features of Office 365 

1. Explore and Integrate: Office 365 Integrates flawlessly with Microsoft Office and other Microsoft 

programs. It takes just a few minutes to create a trial account that users can test and integrate with the 

cloud. 

2. Collaborate Anywhere and at Anytime: With Office 365, users get web-enabled access to documents, 

emails, contacts, and calendars irrespective of whichever device or browser they use. This accessibility 

enables integrated collaboration among employees. 

3. Stay Up and Running AT ALL TIMES: By running your applications in the cloud and storing your data 

thereon, this will ensure all your business documents and applications, such as emails and documents, 

will always be available – even if your company experiences any disaster. 

4. Flexibility: With several options in the Office 365 suite, enterprises buy only the office solutions they 

need and convert CAPEX into OPEX. 

5. Single Sign-on (SSO) – Users can store their password in the system tray of their machine to avoid 

having to repetitively sign in. 

6. Support: Users receive business-class service including IT admin phone support, a financially-backed 

99.9% uptime guarantee, geo-redundant data centers, robust security, disaster recovery, privacy 

controls, and standards and lots more. 

7. Security: Office 365 has built-in security and constant compliance. You always know where your data 

is and who can access it. You can also remotely wipe all data from your mobile device if it’s stolen or lost. 

8. No Licensing Issues: Office 365 includes all licensing and it can be deployed company-wide. This means 

everyone has the same version of Microsoft Office, and all users receive upgrades in unison. 

9. Organization: When you use Office 365, email, calendar and contacts are all synchronized. For 

example, if you update a contact on your mobile phone, it will be automatically updated across all your 

devices. You can also access the same data from any device or save a document on your PC and continue 

working on it, on your smartphone or tablet. 

10. Real-time Collaboration: Teams can collaborate with Microsoft Word, Excel and PowerPoint. Each 

user can see instantaneous edits or additions their colleagues are making to a document. It also saves 

each version robotically, so you can return to older versions easily. This ensures a quicker and simpler 

collaboration between employees and departments, hence, resulting in improved productivity.  

Apps Integrated into Office 365 for Business 

What’s included in Office 365 for Business depends on which subscription level the user chooses, but the 
essential apps and services available through Office 365 are: 

• Word 

• Excel 

• PowerPoint 

• OneNote 
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• Outlook 

• Exchange  

• Publisher 

• SharePoint 

• Microsoft Teams 

• Skype for Business 

• OneDrive for Business 

Some Office 365 applications also have mobile versions to help business do more on the go, including 

Word, Excel, PowerPoint, OneDrive for Business, Skype for Business, Yammer, and OneNote. In addition, 

Office 365 subscriptions also consist of 1 TB of OneDrive for Business cloud storage for individual user. 

Office 365 for Business pricing plans for Small and Medium Businesses (SMBs) 
 

Office 365 Business 
Essentials 

Office 365 Business Office 365 Business Premium 

Apps 

included 

Web versions of 

Word, Excel, and 

PowerPoint 

Desktop versions of Outlook, 

Word, Excel, PowerPoint, 

OneNote, Access, and 

Publisher 

Web versions of Word, Excel, 

and PowerPoint 

Desktop versions of Outlook, 

Word, Excel, PowerPoint, 

OneNote, Access, and 

Publisher 

Web versions of Word, Excel, 

and PowerPoint 

Services 

included 

Exchange 

SharePoint 

Skype for Business 

Microsoft Teams 

1TB of OneDrive file 

storage and sharing 

Microsoft Planner 

24/7 phone and web 

support 

1TB of OneDrive file storage 

and sharing 

24/7 phone and web support 

Exchange 

SharePoint 

Skype for Business 

Microsoft Teams 

Email Hosting 

1TB of OneDrive file storage 

and sharing 

Microsoft Planner 

Microsoft StaffHub 

Microsoft Connections 

Microsoft Listings 

Outlook Customer Manager 

Microsoft Invoicing 

Microsoft Bookings 

MileIQ 

Business center 

24/7 phone and web support 

Email 

hosting 

50 GB mailbox and 

custom email 

domain address 

None 50 GB mailbox and custom 

email domain address 

Device 

licensing 

Services for use on 5 

phones and 5 tablets 

only 

Office apps and services on 5 

phones, 5 tablets, and 5 PCs or 

Macs per user 

Office apps and services on 5 

phones, 5 tablets, and 5 PCs or 

Macs per user 
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Office 365 for Business Pricing Plans for Enterprise 
 

Office 
365: ProPlus 

Office 
365: Enterprise E1 

Office 
365: Enterprise E3 

Office 
365: Enterprise E5 

Apps 

included 

Desktop 

versions of 

Outlook, Word, 

Excel, PowerPoint, 

OneNote, Access 

and Publisher 

Web versions of 

Word, Excel, and 

PowerPoint 

Web versions of 

Word, Excel, and 

PowerPoint 

Desktop versions of 

Outlook, Word, 

Excel, PowerPoint, 

OneNote, Access 

and Publisher 

Web versions of 

Word, Excel, and 

PowerPoint 

Desktop versions of 

Outlook, Word, 

Excel, PowerPoint, 

OneNote, Access 

and Publisher 

Web versions of 

Word, Excel, and 

PowerPoint 

Services 

included 

1TB of OneDrive 

file storage and 

sharing 

24/7 phone and 

web support 

Exchange 

SharePoint 

Skype for Business 

Microsoft Teams 

Yammer 

Microsoft StaffHub 

Microsoft Planner 

1TB of OneDrive file 

storage and sharing 

24/7 phone and 

web support 

Exchange 

SharePoint 

Skype for Business 

Microsoft Teams 

Yammer 

Microsoft StaffHub 

Microsoft Planner 

Unlimited personal 

cloud storage 

24/7 phone and web 

support 

Exchange 

SharePoint 

Skype for Business 

Microsoft Teams 

Yammer 

Power BI Pro 

Microsoft StaffHub 

Microsoft Planner 

Office 365 Cloud App 

Security 

Advanced Data 

Governance 

Customer Lockbox 

Exchange Online 

Advanced Threat 

Protection 

Unlimited personal 

cloud storage 

24/7 phone and web 

support 

Email 

hosting 

None 50 GB mailbox and 

custom email 

domain address 

100 GB mailbox and 

custom email 

domain address 

100 GB mailbox and 

custom email 

domain address 

Device 

licensing 

Office apps and 

services on 5 

phones, 5 tablets, 

and 5 PCs or Macs 

per user 

Office apps and 

services on 5 

phones, 5 tablets, 

and 5 PCs or Macs 

per user 

Office apps and 

services on 5 

phones, 5 tablets, 

and 5 PCs or Macs 

per user 

Office apps and 

services on 5 

phones, 5 tablets, 

and 5 PCs or Macs 

per user 
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Office 365 for Business Cost 

Plan Cost per user/per month 

Business Plans 

Office 365 Business Essentials $5.00 

Office 365 Business $8.25 

Office 365 Business Premium $12.50 

Enterprise Plans 

Office 365 ProPlus $12.00 

Office 365 Enterprise E1 $8.00 

Office 365 Enterprise E3 $20.00 

Office 365 Enterprise E5 $35.00 

 

System Requirements for Office 365 for Business 

Computer and 
processor 

• PC: 1 gigahertz (GHz) or faster x86-bit or x64-bit processor with SSE2 

instruction set 

• Mac: Intel processor 

Memory • PC: 2 GB RAM 

• Mac: 4 GB RAM 

Hard disk • PC: 3.0 GB of available disk space. 

• Mac: 6 GB of available disk space. HFS+ hard disk format (also known 

as Mac OS Extended or HFS Plus). 

Display • PC: 1024 x 768 1024 by 768 screen resolution. 

• Mac: 1280 x 800 1280 by 800 screen resolution. 

Graphics Graphics hardware acceleration requires a DirectX 10 graphics card. 

Operating system • PC: Windows 10, Windows 8.1, Windows 8, Windows 7 Service Pack 

1, Windows Server 2016, Windows Server 2012 R2, Windows Server 

2012, or Windows Server 2008 R2. 
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• Mac: Mac OS X 10.10 or later. 

Browser Up-to-date version of Internet Explorer, Microsoft Edge, Safari, Chrome, or 

Firefox. 

.NET version .NET 3.5 required. Some features may require .NET 4.0, 4.5, or 4.6 CLR also 

to be installed. 

 

How to Create Office 365 Account 

Follow the steps below to set up a Microsoft Office 365 account. 

1. Open your web browser and log on to the Microsoft Office website www.office.com 

2. At the top-middle of the screen, click the Buy Office 365 button. 

3. Here, there are three available options: Office 365 Home, Office 365 Personal, 

or Office Home and Student. Choose the option that best suits your needs. Click Buy 

now for the option that you want. 

4. A sign in window will appear. If you currently do not have an account, click on Create 

one. 

5. Create an account by entering an e-mail address. If you would rather use a phone 

number, click Use a phone number instead, and then enter your phone number. 

Click Next. 

6. Enter a password. I recommend that you click the Show password option, so you can 

be sure of what you are typing. Kindly note that the system does not ask you to type 

in your password twice to confirm it, so make sure you type it correctly. Click Next. 

7. Enter your first and last name, as requested. Click Next. 

8. Depending on the method you used to set up this account, Microsoft sends you a 

verification code to either the e-mail or phone number that you entered. You will 

need to access your e-mail or phone to get this verification code. Enter the security 

code in the Microsoft set up screen. 

9. Select or deselect the box, asking if you want information, tips, and offers (the choice 

is yours). Click Next. 

10. Enter the characters in the reCAPTCHA. 

11. Select payment method. The available options are credit card or debit card, bank 

account, or PayPal. Enter your correct information accordingly and then click Save. 

12. Select or deselect the box, asking if you want promotional e-mails from Microsoft. 

Click Subscribe. 
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13. Once the payment is processed successfully, you will be directed to your Office 

365 dashboard. At this stage now, you can install Office on your computer. 

Click Install Office and follow the prompts on the screen to install it. Depending on 

the speed of your computer and Internet connection, this may take up to 10 or 15 

minutes. 

14. If you set this up on a computer, Microsoft then asks if you want the free apps for 

your phone, as well. If you select yes, Microsoft texts you a link to download the 

apps. Click Next. 

15. You now have access to all programs in the Office 365 suite. Access them by clicking 

the Start menu. 
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CHAPTER ONE 

MICROSOFT WORD AT A GLANCE 

In this chapter, we'll begin by looking at the Microsoft screen, gaining an overview of everything we'll be 

looking at on the screen so you can begin to recognize some of the options available to you. You will get 

an overview of some of the features inside of Microsoft Word and grasp some of the languages we'll be 

using throughout the book. 

The First Step 

Before you even think of getting any job done in Microsoft Word, you should know this very important 

part which is how you can get it up and running on your computer. Without further ado, let's see how 

you can get Microsoft Word entirely for free. First, you'll see how you can get Word on the web, and 

secondly, you'll know how to install Word on your pc also entirely for free. Well, let's jump on the PC. 

From The Web 

You can get Microsoft Word for free on the web by going to the website office.com. Once you land on 

office.com there are three different options. If you already have a Microsoft account, let's say you use 

skype or you've used office before, chances are you already have an account and you could simply sign 
in. 

 

If you don't have a Microsoft account, don't worry, you can also sign up for the free version of Office by 

clicking on the sign up for the free version of office link as shown below and this will prompt you to set 

up a new Microsoft account. 
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There's also a third option over here to "Get Office". This brings you to a marketing website where you 

can purchase Office. 

 

So, you go ahead and sign in. Once you click on sign in, office.com gives you free access to Microsoft 

word; not only do you get Microsoft Word, you can also get Excel, PowerPoint, and a whole bunch of 

other very powerful apps but for this book, we're focused on Word. 

Over on the left-hand side to kick off a new Word document you can click on the "Create" icon and 

right up at the top you can start a new Word document. 
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Also, if you go down here you can click on the Word icon and this drops you to the Word start page. Here 

too you can also start a new document or you could jump into one of the available templates or browse 

for more templates.  

Once you've been using Word on the web, you'll be able to get back to all of your recent documents down 

below. Back on office.com, let's say that you have a Word document that you had started on your 

computer or you started working on it somewhere else and now you want to work on that document on 

the web. Well, you can easily get a document from your computer or maybe a flash drive and send this 

to the web. How do you do this? All you need to do is simply get your document and then drag and drop 

it onto office.com.  

You'll see a blue highlight appear and once you release it, here you see that it automatically uploads it 

for you and if you wait a moment this will automatically open it in Word. 

This has now opened this document in word and although you're working on a document using Word 

online that doesn't mean you can't take that document and get it back onto your computer. Up in the 

top left-hand corner under the File menu, there's the option to "Save as" and when you click on that, you 

can save a copy online under any name you want. 

 

Also, right down below there's the option to download a copy to your computer; you could take a 

document, upload it, work on it using Word online, and then you can download a copy again to your 

computer, and not only can you download a Word document you could also get a PDF and an ODT.  
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You might be wondering why you would ever want to install Office when you could use Word on the web. 

Well, with Word on the web you have to be online. Also, it's missing some of the functionality that you 

find in the desktop app but it has the functionality that you're likely going to use most often. For Example, 

the Table of contents is now available on the web.  

 

Also, one thing that might surprise you is that the web has some functionality that the desktop version 

of Word does not have. Here for example, under the home tab if you go over to "Dictate", you can take 

an audio file and have Word online transcribe that for you; that's not something you could do on the 

desktop. 

 

An even easier way that you can access Word on the web if you're on a Windows 10 or 11 computer is 

if you have Windows 10 or 11 and it includes an app called Office. To access this app simply go down to 

the taskbar, click on "Search" and then type in "Office".  
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You'll see the best match appear for the Office app, you go ahead and click on that. This opens up the 

Office app and it looks very familiar to what you just saw on Office.com.  

 

Here too you can access Word the same way. In the top left-hand corner once again, you can click on the 

"Create" icon and here you could kick off a blank new Word document. Also, if you click on the Word icon 

on the left-hand side this will bring you to the Word start page, and just like before you could kick off a 

new document, jump into one of these templates and you can also get back to recent documents. 
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This is one more way to access Word on the web. One of the very nice features is that down here on your 

taskbar you'll see the Office icon, if you right-click on this you can get back to recent documents, 

PowerPoints, Excel files, and you can also kick off a new document directly from here so you don't even 

have to open the app to kick off a new word document. 

 

Switching On Your Desktop 

Now that we've looked at how you can get Word on the web entirely for free, let's see how you can install 
Office on your desktop. First, let's look at the approach that you can use if you're a student, a teacher, or 

an administrator at an educational institution. Head over to the URL below. 

 

Once you land on this page, you can type in your school email address below, and once you finish 

typing in your email address click on "Get started" to see if you're eligible to download and install Office 

for free. 
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After you type in your email address, it'll ask you if you're a student or a teacher, so select the one that 

you are and when you finish signing up for your account, once again you'll land on the website that we 

saw earlier and that's office.com.  

 

If you're eligible on office.com, in the top right-hand corner you'll see an option to install Office. When 

you click on this you can then install all of the Office 365 apps; it includes things like Outlook, and 

OneDrive for business, and here you get Microsoft Word. 

 

Now if you don't like using Word on the web and you're not a student or a teacher (so you don't qualify 

for the education deal), you can still get Word on your computer entirely for free and you're going to 

use something called Microsoft Rewards to get Microsoft Word for free. 

You might be wondering what Microsoft Rewards are and how this will help you get Microsoft Word.  

Well, Microsoft Rewards is a program that Microsoft created to reward you for using Microsoft 

products, which means the more you use Microsoft products, the more points you get, and then you 

can redeem different things with those points. For example, you could get Microsoft Word but you 

could also get all sorts of other things like gift cards from many different retailers.  

To get to Microsoft Rewards head to the URL below. 
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Here you could either sign up for free (if you don't yet have a Microsoft account), but if you already 

have a Microsoft account you can go ahead and click on sign in. 

 

After you've signed in you might be wondering how you earn points. There are three different ways that 

you can earn points. The first way to earn points is to search on Microsoft Bing; simply head to bing.com 

and then you can type in your search query. The second way to earn points is to search using Bing on 

your phone; here you're going to type in a word, click on search, and once again you just earned even 

more points. The third way to earn points is to use the Edge browser when you're searching on bing.com. 

Those are the three different ways that you could earn points and if you want a quick reminder of how 

you could earn points on the Bing rewards homepage, over on the right-hand side you can click on the 

option that says Points breakdown.  

 

Here you'll see how many points you've earned daily and how many potential points you can earn. You 

can earn up to 270 points per day or about 120 per year and that's more than enough to buy Microsoft 

Word. 
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If it feels painful to have to earn all of these points, think of it this way: you likely already search on the 

web anyway and so if you just make Bing part of your daily habit of searching on your pc and searching 

on your phone, you're going to start accruing points very quickly and you're going to get word and lots 

of other things entirely for free. 

After accumulating your points over some time, you can redeem your points. On the left-hand side, 

you'll see a tab that says "Redeem".  

 

Click on that and within this page, on the left-hand side, click on Shop. 

 

Within Shop you'll see all different types of gift cards that you can redeem with your Microsoft points. 

Here, for example, you can get an Xbox gift card, you can get Skype credit, and below that, you can shop 

with different retailers. To get Microsoft word for free you're going to redeem either a gift card at Target 

or Walmart.  
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If you're in a market where there is no Walmart and there is no target, there should be local retailers in 

your market where you can get a gift card, and then you can use that gift card to purchase Office. Once 

you pick up your gift card with either Walmart, Target, or whoever the retailer is in your local market, 

you can search for Microsoft 365, and here you can get a personal version of Microsoft 365. This gives 

you access to Word along with all of the other Microsoft 365 applications. The only downside with 

Microsoft Rewards is that it's currently not available in all markets. If you're in a market that doesn't 

support Microsoft Rewards, well, unfortunately, this technique won't work for you but hopefully, some 

of the other techniques will work and you'll be able to use Word entirely for free.  

Starting Word 

So how do you start Word on your computer? Well, there are a couple of options. First, if you have the 

icon already pinned to your taskbar, you can click on that button.  

 

If you don't see this down there, you can go over here to the search bar and type "Word", it should 

appear up there, and you can click on that icon.  
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A Blank Document 

When you first launch Word, you'll be confronted with the home page, which displays a list of recent 

documents in the main body of the screen. They're all displayed under here, you can just double-click 

on any of them to open that document.  

 

This is a convenient way to quickly access files you've recently worked on. So that's a little bit of 

information on how to access recent documents, but what we want to focus on here is how to create a 

blank document, and if you look just above that Recent list, the first thing you'll see is a Blank document. 

It's quite simple; just choose "Blank document" to make a new one. But before we do that, let's have a 

look at some of the other options you have in this area for creating new documents. If you don't want a 

blank document, you may create one based on a template, and Word provides a variety of different 

templates to choose from. 

 

Now, if you've never used a template before and aren't sure what they are, it's just a good starting point; 

for example, if you know you need to create a resume or some meeting notes, you can search for a 

specific template related to a resume or meeting notes, and it will already have a lot of the information 

or layout that you need for that particular document. You can see some templates at the top here, and 

if you click on the "More templates" link, you can go through and take a look at some of the templates 

that are available for you to use.  
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There are a lot of them in here, and they're worth checking out if you've never been into this section 

before. 

 

If you're looking for something extremely particular, such as a resume, you can enter it in, click the 

magnifying glass, and it will search the templates, bringing up a list of all of those Resume templates. If 

you find one you like, you can just click on it and begin working on it. 

 



 20 

You can just pick a Blank document if you don't want to utilize a template. So now we've generated a 

blank document, the first thing you should notice is that if you look up to the top of the screen, you'll see 

what we refer to as the Title bar, which currently states Document 1, indicating that this document hasn't 

been saved yet.  

 

You'll see that when you create a new blank document, the default name is document 1, 2, or 3, and so 

on, just be aware of that since you'll notice this change when we save this document later. 

Ribbons and Tabs 

Home, Insert, Layout, View, Draw, Mailings, Review, Developer, and Help are some of the tabs on this 

screen.  
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What you see on your computer may alter somewhat from what we have here, depending on which of 

these tabs you have selected, but in general, you will see these tabs running across the top, and what 

these tabs contain or what we refer to as Ribbons, which contain all of the commands that you require. 

If you click on the home tab, for example, you'll see the home ribbon, which has all of the commands that 

run across the top of the screen, and these commands are generally organized into their appropriate 

ribbons. The commands that you use the most are found on the home ribbon, and we'll go over some of 

them later in this chapter, but just know that they're ordered logically with their respective commands. 

Before we go any further with these ribbons, it's worth noting that if you're on the home ribbon, you'll 

notice that the commands are organized into groups; for example, we have Clipboard, Font, Paragraph, 

and Styles. At the bottom of each of those groups, you'll see a little downward arrow, and if you click 

that, you'll find more advanced options or more options related to that group, so just be aware that 

you're not limited. If it has a drop-down arrow, you'll most likely discover some more complex commands 

in there if you click on it. 

Inside Word 

Once you're inside Microsoft Word, you have a lot of options here. The first option is to start with a 

blank document, which is most likely what you want to do.  

You also have several options over here on the left. You have the home screen, New, Open, Account, 

Feedback, and Options.  

 

Home is selected by default. Under the “Recent” tab are recent documents that have been opened. 
Under the “Pinned” tab is any document that you want to open often, these will be very frequently used 

files, and the way you get them in the pinned list is by going to “Recent” and clicking on the pin icon right 
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there, then when you go back to the home button, go back to the Pinned tab and you will see that 

document now resides under the Pinned list. "Shared with me” will be any documents that have been 
shared with you over OneDrive.  

If you go to “New”, you can either select a blank document or you can look through all of the templates 

down here that Microsoft Word has provided for you. These templates allow you to quickly begin a 

resume, a calendar, or a lot of other frequently used documents such as brochures and reports.  

 

If you go to the Open menu, you can see a lot of files that you have opened recently, more so than you 

can see on the home screen. If you go to Browse, you'll be able to find a document on your computer. 

And if you go to OneDrive, you'll be able to see any kind of documents that you've shared with 

everyone else, or people have shared with you. 
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The Account menu tells you information about your Microsoft Office subscription and gives you 

different options for setting defaults for Microsoft Word 

 

The Backstage View  

It's worth mentioning that the backstage view is available in all Microsoft Office programs; for example, 

if you're using PowerPoint, Excel, or even Outlook, you'll see a backstage view. You might be curious as 

to where it is and how to get to it. To put it simply, it's the File tab at the top. 
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If you go to File, you'll see the backstage view, which is where you'll see all of your document's mini-tasks. 

So, starting with the menu that runs along the left-hand side, we can see that it's divided into a few 

divisions. We have three icons in the top section: Home, New, and Open. If you click on “Home,” you'll 
be sent to the home screen, which we'll discuss in more detail later. 

 

Then there's "New," which is where you'd go if you wanted to make a new document, either a blank 

one or one based on an existing template.  
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There's also "Open," which is where you'd go if you wanted to open a fresh file or one, you'd saved 

somewhere. 

 

In the "Info" section, you'll find all of the details about the document you're now working on. If you 

haven't saved your document or it doesn't have any content in it yet, there isn't much information to 

show you about it in this section. You'll discover all the attributes on the right-hand side, and you'll see 

that these will alter if you start doing some of those things. 

 

For the document above, you can see that it now says the document isn't saved, that it has one page and 

zero words, and that it tells us how long we've been in that file. We could go through and add a title and 

tags to help with searching. So just keep in mind that if you're seeking information regarding the file 

you're currently working on, this is a good place to start. 
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If we return to the left-hand side, we'll find some more items that we may utilize in our document. The 

first option is "Protect Document," which allows you to limit the types of changes that others can make 

to your document. So, if you're sharing this document with others, say, if you've sent it to a client, a 

coworker, or someone else on your team, you can have some control over what they can do with it; for 

example, you can apply some editing restrictions if you want, and that's where you'll find all of those 

kinds of options, which we'll go over in more detail later. 

 

We then have an "Inspect Document" option, which allows you to inspect or conduct a quick check on 

your document once you've done it to ensure that it has some features that make it available to others 

and that there are no incompatibility issues. This means that if you're using Word 2025, you should be 

aware that someone you're sharing the document with might be using an older version of Word, so it's 

worth pointing out or highlighting in your document or figuring out which elements they won't be able 

to see because some functionality in 2025 isn't available in older versions. 
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Let's imagine a new typeface was released in 2025, and you used it in your document; if you shared it 

with someone who doesn't have that version of Word, they might not be able to see the font you chose, 

and the same is true for other things. It's always a good idea to check if your document is compliant and 

make any necessary adjustments before sending it out, and you can do that by clicking the "Inspect 
Document" option. 

We also have a section called "Manage Document," where you may go back and recover unsaved 

versions of your document. We've probably all done it at some point: begun typing forgot to save, and 

then quit the program, believing we'd lost everything. One of the nice things about Word 2025 is that it 

saves your documents automatically. If you had prior versions, they will appear on this "Manage 

Document" screen, and you may click to restore them. This is a lifesaver, so make a mental note of where 

that button is located. 

 

Then there's "Save" and "Save As" beneath that. These two operate in a somewhat different manner. 

You'll notice that when you click "Save," you must first save your document before you can use it. If you 

click "Save" right now, it will take you to the "Save As" region and ask you where you want to save your 

document because you haven't done so yet. If you'd already saved your work and merely wanted to save 

some modifications, you could just click the "Save" button, which will appear to do nothing but save the 

changes to the file name. 
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The difference between the two is that one is used to save a document that has previously been saved 

as a name, while the other is used to pick a folder and save a document for the first time. 

You'll now be able to find past revisions of your work in the "History" section. 

Then there's "Print," which does exactly what it says on the tin. If you've written a beautiful document 

and want to print it, you can come in here, choose your printer, and see all of your printing options. 

 

There is a "Share" option in this section that will allow you to share your document in a variety of ways. 

You have the option of emailing it, saving it to the cloud and sending a link to individuals, presenting it 

online, or even posting it to a blog. When it comes to sharing, there are numerous alternatives. 
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You should use "Export" primarily if you want to create a PDF file. If you've never used a PDF before, it's 

essentially a version of your document that's very difficult to modify, so if you want to secure your 

document or don't want people to be able to simply go in and alter it, it's always worth saving or 

producing a PDF of it before sending it. There is a lot of software available these days that allows users 

to alter PDF files, but in general, if you want to add an extra layer of security, producing a PDF is a good 

option, and this is where you would go. 

Finally, at the bottom of the page, there is a "Close" button that will close your document. 

Our third and final piece is at the bottom. We have the "Account," which simply displays information 

about your account, including personal information and the Office version you're using. 

 

We have a "Feedback" button, if you want to be helpful and provide Microsoft with some useful 

feedback, you can utilize it. 

Finally, there's the "Options" section, which we'll go over in-depth later, but it's where you'll find all of 

the little things you can set as defaults and small modifications you can make to how Word works in 

general for you and how it is specific to use. This will allow you to personalize the way your Word version 

functions, and there are a lot of options here. 
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One other thing you'll notice in this backstage view is the back arrow at the top, which does exactly what 

you'd expect it to do: it returns you to the document you were in. 

 

Now, let's go back to Microsoft Word. 
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The Home Tab 

If you click the home tab, you will see that the home ribbon comes up, and you have a lot of options here. 

Now if you have some text in your Word document and you would like to be able to see this closer up, 

you can go to View, Zoom, and change this so that you can see closer up what you are doing with all of 

these options on the home tab.  

 

Back to the Home tab, if you double click with your mouse on any word, you will select the entire word. 

Here you can bold, italicize, or underline your text. 

You can also use the strike-through option. If you're editing someone else's paper but you want to leave 

what they had originally put in the text, you can use the strike-through. You can also change the color of 

your font, you can highlight all of your text and center it, right-justify or left-justify it. You can also change 
the spacing when you have paragraphs right here. You can add bulleted points, and number points and 

you can even make this an outline if you have multiple lines on here. With the Indent button, you can 

indent or you can out-dent. You can also highlight your text. Over here on the right side, you can dictate 

a new sentence if you would like. These are some of the options in the home ribbon.  



 32 

The Insert Ribbon 

In this tab, there are a couple of options we should review. First of all, in Word, you can insert a table of 

information so that all of your rows and columns are lined up and are formatted well. 

 

Clicking on the Pictures tab allows you to insert a picture. You can insert pictures from your device, you 

can use stock images, or even get pictures online and into your document. 

There are a couple of other things you can insert including Shapes, Icons, Screenshots, Online videos, 

Links, Symbols, and Equations, among others. 

You can also insert the page number on your document by going to the button on top of the page, 

whatever your preferences are for page number, and then you can make your page number be on the 

left, center, or right. 

The Layout Ribbon 

On the Layout, you can change the margins of your page. The normal setting is 1inch all around but you 

can also customize those margins and make them whatever size you would like by hitting "Customize". 
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You can change the orientation of your page from Portrait to landscape. 

 

You can also change the size of your paper here. 

 

Here's one that is used often; sometimes you may want to insert a page break and have information 

print on a different page. What you would do is go to "Breaks" and hit “Page”.  
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If you scroll down, you will see that the page break is right there. Sometimes that's very useful when 

you have one sentence appearing at the bottom of a document that you would prefer for it to go onto 

the next page. But be careful with that because, as you add words to your page, the page break will 

remain in place, and your text may spill over onto another page, yet leave the page break and it might 

not look right. 

The Review Ribbon 

There are some options here that are very useful when you are working with Microsoft Word. Let's say 

you want to make your paper a little more exciting and you have a word in your document that you 

don't like and you would like to use something more emphatic. if you double-click on the word and go 

up to "Thesaurus", you can now see different words that could be used to replace that word.  
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If you click on the new words and insert any of them, you can see that you have now replaced the 

synonym with the initial word. 

 

You can also click on “Word count” and see how many words you have on this page. In the Status bar, 

you can see how many words you have on your page as well. 
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The View tabs 

On the View tab, you can zoom in and out of the document that you are working with. 

 

You can also pick “Multiple” to see how many pages you have within your document and get a rough 

idea of what it's going to look like when you print it out. 

You can also switch windows to any other document you may have opened at this time, or for a shortcut 

on that you can press Alt + Tab on your keyboard and switch between word documents as well. To go 

back to the regular view that you've been working with, click "One Page", click on zoom, and go back to 

your regular view. 

 

What if You Can't Remember All of These? 

One more thing you should note is up there in the “Search” bar. This is true for all Microsoft Office 

applications.  
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If you can't remember one of the commands we went over and you click in here and type a word, you 

will see it right up here. With that, instead of having to search for the ribbon, you can type in the 

command of what you would want to do until you get a little more familiar with the environment inside 

of Microsoft word 

Changing the View of your Document 

This is where we'll find our views, all the way over on the right-hand side. This is just a quick way of 

switching between views, and these buttons correspond to how you're now looking at your document. 

As you can see, the first one is Read Mode, and switching to it provides you with a fresh perspective on 

your paper. It removes almost everything on the screen except your document, allowing you to see more 

clearly what you're looking at. This is useful if you're trying to read a document. The Print Layout view is 

the next one we have; it's the one you'll be in by default, and it's the one you'll be in most of the time 

when you're working on your papers. The Web Layout view is the next one. So, if you're creating 

something for the web, or if you want to incorporate things like HTML code, you'd go into this Web Layout 

view and create your document that way. 

 

That’s Not All 

We have what we term the Quick Access Toolbar found directly beneath the ribbons, and this toolbar 

contains a few different commands that you can configure. Its entire purpose is to provide you with quick 

access to the commands that you use the most frequently, which will differ widely from person to person 

based on what you do in your everyday work.  
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If you click the drop-down at the bottom, you'll notice that you have a lot of alternatives for adding to 

that fast access toolbar. The ones that are currently checked are already in the toolbar, but you can add 

any of the ones listed here if you want.  Alternatively, if you want a command that isn't mentioned here, 

you can browse for more commands and choose something to add to the Quick Access Toolbar from 

there. 

 

Moving to the top of your document, you'll notice a ruler running across the top and a ruler running down 

the side. On this top ruler, you might notice some small triangles in the little block at the bottom. It says 

Left indent, Hanging Indent, and First Line Indent when you hover over it, and this helps you align the 

text in your document; so be aware of the ruler and the Indent functionality in there. 
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The Status bar is located at the bottom of the screen, and on the left-hand side of the status bar is some 

general information about our documents. You can see from the image above that we're in section 1 and 

on page 1 of 1. We presently have no words in the document, and it also indicates that our language is 

set to English (United States), but these will undoubtedly alter as we begin to add content. 

 

It's also worth mentioning that the View ribbon at the top can also be used to access various options, 

such as views and zoom. You can see in the first group that we have our layouts, as well as a couple of 

extra views and some zoom possibilities. 

 

The Scroll bar on the side of the Word screen is the last thing to mention. So, you can go up and down, 

and if you have more pages, you'll be able to scroll through all of them. 
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So that's a summary of what you're looking at on your Word screen right now, and hopefully, that's gotten 

you a little bit more familiar with the terminology we'll be using throughout this book, and it's a nice 

foundation for us to leap off into our following chapters. 
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CHAPTER TWO 

TYPING MASTERY 

In this chapter, we'll look at how to get started typing, some of the minor things you'll notice when you 

start typing your first documents, and several keyboard shortcuts that will help you out while you're 

typing.  

What Happens When You Type? 

There are a few things to keep in mind when typing your first document. We'll look at these things to 

familiarize you with the typing interface, which will help you prevent mistakes and make typing easier 

and more enjoyable. 

The Margins 

You'll notice that the cursor is flashing, but it isn't flashing directly at the page's left-hand edge. This is 

because there is a left margin of approximately an inch in there, and you can see that as you start typing, 

all of your text will start coming out there. 

 

So, after typing a basic line, if you continue typing when you reach the end of a row, you won't need to 

hit the enter key to move on to the next line; it will automatically wrap as you type, you can just keep 

typing and it will wrap itself around, eliminating the need to hit enter at the end of a line. 

If you want to force a line break, for example, if you were on a line and wanted to do anything on the 

following line, you can hit the enter key, which will take you down to the next line and allow you to 

continue typing. 
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Capitalizing the First Letter 

Another thing to keep in mind is that if you start typing a sentence at the beginning of a line and don't 

capitalize the initial letter, Word will capitalize it for you. So, if you just start typing, you'll notice that it 

has capitalized it for you without you having to go back and change it. This is because of Word's 

autocorrect feature, which recognizes certain words and changes them for you, making your life much 

easier. In the following chapters, we'll go over a lot of the autocorrect settings. 

Colorful Underlines Explained 

There are a few more things to keep in mind. 

If you misspell a word, you'll notice a red squiggly underline, which indicates that you've made a mistake 

with that word. So, you can hover over the word and right-click your mouse to bring up a menu of 

possibilities, and more often than not, the term you're looking for will be among them. If it isn't, you'll 

have to go in and manually make the change. 

 

If you add a comma and/or a double space to a sentence, Words will detect a problem. There's a 

grammatical issue, and this type of error is fairly common, especially when you're working quickly. You 

might accidentally type a comma, or hit the spacebar twice, but you can see now with the double 

underline that if you right-click it tells you how to rectify it. 


